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Overview 
Abstract 
Cassandra is a generic 3D scientific data viewer written in Java, based on VTK and providing a native 
multiplatform support. Including most of the current filters (clipping, cutting, colour mapping, elevation, 
etc...), Cassandra can be used for 3D visualisation and data analysis as well as in pre/post processing 
phases. Its modular design, based on plug-ins, allows numerous possibilities of extension and 
adaptation to specific purposes. Cassandra's User Interface (UI) offers several levels of interaction, 
including an advanced graphical pipeline manager to facilitate the compositions of processes and a 
Jython console for the fine control of low-level components, like VTK objects. 
 
Cassandra is the result of the internal R&D effort of Artenum Company in scientific data visualization 
and analysis. Cassandra illustrates Artenum's know-how in VTK and high performance Java 
developments [1][2]. Cassandra is used for many applications in scientific computing, energy and 
space environment analysis. Cassandra is supported by the Artenum Company and an increasing 
scientific and industrial community.  
 
The present document corresponds to the Cassandra's User Manual (Cassandra UM) and focuses on 
a quick-start in the use of the software. This UM is compliant with the version 2.4.03 of Cassandra and 
the default set of plug-ins. Please see the Cassandra Web page and the related documentation for 
additional plug-ins.  
 
Products and services 
Cassandra is a fully open-source project and is freely available free of charges under the terms of the 
GPL license. In complement and in order to provide a professional tool, Artenum proposes a 
structured set of related services, including: 
  

• On-demand development and extension; 
• Close-source development license; 
• Additional close-source plug-ins for advanced processing; 
• Expertise and study-case analysis for tailored data analysis and visualization processes; 
• VTK and data analysis training  

 
Please feel free to visit on our Web site (http://www.artenum.com) or contacts us      
(contact@artenum.com) for further information.  
 
Cassandraʼs Web page: http://www.artenum.com/cassandra 
 
Cassandraʼs development area: http://dev.artenum.com/projects/cassandra 
 
 
Contact 
Post address: Artenum SARL , 24, rue Louis-Blanc, 75010 Paris –  France 
 
Phone:  +33 (0)1 46 94 67 54 
Fax:  +33 (0)1 46 94 67 54 
E-mail: contact@artenum.com 
Web Site: http://www.artenum.com 
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1. Introduction 
Cassandra is a generic 3D scientific data viewer written in Java, based on VTK and providing a native 
multiplatform support. Including most of the current filters (clipping, cutting, color mapping, elevation, 
etc...), Cassandra can be used for 3D visualisation and data analysis as well as in pre/post processing 
phases.  
 
In its default package Cassandra, provide a large set of filters and data processing tools, like cutting 
planes, colour mapping, iso-level extraction, threshold extraction, vector fields representation… Btu 
thanks to its modular design, based on plug-ins, allows numerous possibilities of extension and 
adaptation to specific purposes.  
 
Cassandra's User Interface (UI) offers several levels of interaction, including an advanced graphical 
pipeline manager to facilitate the compositions of processes and a Jython console for the fine control 
of low-level components, like VTK objects. 
 
Cassandra is also a simple and efficient tool to discover and learn powerful capabilities of VTK in the 
Java and Jython contexts. The Graphical Pipeline Editior and the scripting facilities simplify the access 
to VTKʼs key-concepts for beginners and provide useful tools to the expert to develop in a simple way 
business and advanced scientific data processing tools based on VTK and Java.  
 
Cassandra is the result of the internal R&D effort of Artenum Company in scientific data visualization 
and analysis. Cassandra illustrates Artenum's know-how in VTK and high performance Java 
developments [1][2]. Cassandra is used for many applications in scientific computing, energy and 
space environment analysis. Cassandra is developed by the Artenum Company and used an large 
scientific and industrial community.  
 
The present document corresponds to the Cassandra's User Manual (Cassandra UM) and focuses on 
a quick-start in the use of the software. This UM is compliant with the version 2.4.03 of Cassandra and 
the default set of plug-ins. Please see the Cassandra Web page and the related documentation for 
additional plug-ins. 
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2. Key features 
2.1. Pipeline viewer and editor 

Cassandra is composed of a graphical pipeline editor that simplifies the understanding and the 
manipulation of the data processing and visualisation. This graphical representation of the VTK 
pipeline provides a rich interaction between the users and the data to process. 
 

2.2. Dynamic plug-ins system 
Cassandra works on top of a dynamic class loader, which allows dynamic class integration such as 
plug-ins with dedicated filter processing. 
 

2.3. Dynamic object manipulation 
Cassandra integrates an advanced Jython console for the hot manipulation of Java or Jython objects. 
This console can be used to load Jython script in order to extend the plug-in approach with the script 
approach. It has become possible to write a script in order to generate animations and export them as 
a set of images or movies. 

 

2.4. Cassandra architecture 
Cassandra provides a powerful framework for manipulating VTK data. It is based on a dynamic class 
loader for loading external plug-ins at runtime and a powerful VTK pipeline manager that allows a 
graphical representation and manipulation of the VTK pipeline. 
 

 

Figure 1: Schematic architecture of Cassandra.  

 

2.5. Cassandra GUI overview 
The Cassandra graphical interface is divided in three main areas that have different usage. The first 
one is used to manipulate and change the input data. The second one is the 3D view that is used to 
manipulate the 3D object by rotating and scaling it. The last one is the console that allows hot 
manipulation of Java and Python objects. Each graphical section can be hidden or reduced in order to 
enlarge or view another component. 
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Figure 2: General review of the Graphical User Interface (GUI) of Cassandra 

2.6. A context driven GUI for a simpler life 
Efforts has been done to simplify as much as possible the user interface to simplify the use of the 
application, especially for non-experts in 3D data analysis and visualisation. In this logic, buttons and 
control components are displayed only when this is necessary only through contextual menus and 
control panels, and in function of the handled element.  

The global approach is:  

1) Select in the pipeline editor the element to be edited/controlled/modified; 

2) Perform on this element a right mouse click, a contextual control menu should appear;  

3) In the contextual menu, select the targeted action, a control panel should appear with all 
needed widgets, controls and buttons.  

4) Perform your settings and validate by clicking on the update button. The process should be 
done or updated.  

5) The control panel can be close by clicking on the escape button.  

NB: When a new process (i.e. plug-in) is called the control panel is automatically opened.  

Figure 3 shows an example of control panel of a cutting plane filter.  
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Figure 3 Example of control panel for the cutting plane filter. 
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3. Cassandra usage 
3.1. How to run Cassandra? 

Cassandra can be launched in two different ways on each system. Each system has its own launching 
script which will automatically set the global variable for the local VTK binaries. If you already own a 
VTK installation, Cassandra can be launched by executing the following commands:  

• Under Linux/Unix/Apple MacOSX command: Cassandra.sh 

• Under Microsoft Windows based system: Cassandra.bat 

Trouble shootings: On some Windows systems, if the starting script does start properly, 
you may have to correct manually the VTK system variable (LD_LIBRARY_PATH, PATH). 
 

3.2. Load a data set file 
Go to the “File” menu then “Open”, and select your input VTK file. By default, you will only see the file 
that ends with the VTK extension. You can repeat this operation in order to load several data in the 
same view.  

In our example, we will load two files, the first one will be a satellite and the second one its surrounded 
plasma environment with the electrical potential as the data visualisation. 

        

Once the files are loaded, you should be able to see your data inside the 3D VTK panel on the right 
side of the Cassandra GUI. You can rotate, scale and move it with the different mouse movements 
and buttons. 

On the left side, several tools for manipulating your data are available.  

• In the View tab you are allowed to show or hide quickly 3D objects. 
• In the Tree tab you can reach the structured tree of objects where you can access their dedicated 

contextual menu. 
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View tab         Tree tab 

• In the Pipeline tab you can see the data processing with the links between filters, data and objects 
with direct access to their contextual menu for their specific properties in order to manipulate 
them… 

Actor manipulation: 
•  Making it visible or not. 
• Changing opacity. 
• Assigning a colour when you unselect the view of scalar data on the mapper. 
• Rename the object. 
• Remove the object. 
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Examples of actor control.  

 

3.3. Apply a simple filter 
Go to the “Filters” menu and select the one you want to add to your VTK pipeline. In our example, we 
will start with a cutting plane, in order to look at the plasma potential around the satellite along a plane. 
 
Steps to follow: 
a) Add the filter to the pipeline by selecting it in the Filters menu. 

        

b) Go to the control panel of the filter in order to set the data to process and specify the property of our 
filter. Since you update your control input, the pipeline will be updated automatically and you will be 
able to see the flow of the data processing. 
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Example of settings of a simple filter, here cutting plane. Left image shows how to access to 
the filter contextual menu. Right image show how to select the input data set.  

 
c) In the cutting plane filter, you set a point inside the plane and the normal of that plane. The slide bar 
is used to move slightly around the specified point easily. It enables you to move the plane back and 
forward around the normal vector as a unit. 

 

Figure 4: Contextual control menu of the cutting plane filter. 
 

3.4. Composition of filters 
Go to the “Filters” menu and select the one(s) you want to add to your VTK pipeline. In our example, 
we will add an iso-level on which we will apply several cutting planes in order to see the field lines. On 
top of that, we will cut the range of the data with a threshold filter. 

Steps to follow 
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a) Add the filter to the pipeline by selecting it in the Filters menu. (1x Threshold – 1x Iso-Level – 2x 
Cutter) 

        

 

        

        

b) Go to the control panel of the filter in order to set the data to process and specify the property of our 
filter. Since you update your control input, the pipeline will be automatically updated and you will be 
able to see the flow of the data processing. 
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Figure 5: Example of complex processing by composition of basic filters. 
 

3.5. Managing several scales and lookup tables 
Every time a new date is loaded or a filter added, a dedicated lookup table and a scalar bar appear 
with its own reference (i.e. min-max).  

If a common values to colours range conversion is needed, to compare data with a unique lookup 
table and scalar bar for instance, lookup tables should be linked to one dedicated mapper. This is 
done through the lookup table contextual menu as follow. 

        

 

The position of the colour bar can be changed in its control panel, accessible from its contextual menu. 
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Figure 6: Setting of the position and visible information of the colour bar. 
 

3.6. Removing components 
It is possible to remove unnecessary items from the contextual menu.  

 

Figure 7: Simplification of the pipeline by suppression of unused items. 
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3.7. Saving generated view 
The 3D view can be saved by the “Save as image” button on the toolbar or directly in the file menu by 
the “Save image” item. This will use the TIFF image format. 
 

3.8. Using the Python console 
The Jython console integrated into the Cassandra application allows the user to call directly the 
method on the Java object. Moreover, the completion helps the user to see which operation can be 
done on that object. To access the completion just press CTRL + SPACE keys. All low level VTK 
functions are available. 
 

 

Figure 8: Object completion in the Jython console (JyConsole). To access to objects 
and methods, just type on CTRL + space touches. 

 

Figure 9: Example of direct access to loaded data (i.e. data set and filters) through the 
JyConsole. 
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3.9. Loading an external Jython script 
Cassandra processing can be fully scripted through Python/Jython scripts. To load a Python script, the 
use has to go to the contextual menu of the console by right clicking the console window and select 
the script to be loaded. All low level VTK functions are available.  

 

Figure 10: Example of scripting capabilities of Cassandra, with and external Jython 
script loaded. 
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4. Core plugins 
In Cassandra data processes are done in dynamically loadable plugins and, by the way, the number of 
processes being performed by Cassandra is extensible and variable from one package to another one. 
However, Artenumʼs team and the Cassandraʼs community regularly develop new open-source plug-
ins that are directly provided with the standard package of Cassandra. The present section describes 
these core plugins, their functionalities and use.  

4.1. Cutting plane 
The Cutting Plane filter performs the cut of a data set along a given plan. Position and orientation of 
the plan can be defined dynamically through the control menu or using 3D control widget.  

 

Figure 11: Example of application of the Cutting Plane filter. Two cutting planes are 
showed here. 

 

Figure 12: Example of the 3D widget to set the cutting plane. 
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4.2. Clipping filter 
The Clipping Filter performs the same cutting than the Cutting plane but keep one of the half space.  

4.3. Generic Cutter 
The Generic Cutter performs similar operations than the Cutting Plane but on various types of 
geometrical support (e.g. Sphere, cylinder...).   

4.4. Outline box and actor axis 
The Outline box and axis filter draw the outline and/or the axis surrounding the input data set.  

4.5. Iso-levels filter 
The Iso-level filter computes the iso-levels of the input data set.  

4.6. Probing line filter 
The Probin Ling Plugin allows probing, by local interpolation, an input data set along a given line. 
Figure 13 shows an example of usage of the proging line.  

 

Figure 13: Example of the use of the Probing Line plugin. The line position and 
orientation can be set using the 3D widget. 

Probed data can be exported into ASCII raw based files as illustrated here below.  

Example of ASCII output of the probing line.  

# index x y z s value   
0.0 -0.069073244929 0.006387104745 -0.04443041926 0.0056911727 0.0  
1.0 -0.077286377549 0.042237780988 -0.02714911662 0.0415418491 0.0  
2.0 -0.085499517619 0.078088490214 -0.00986781062 0.0773925302 0.0  
3.0 -0.093712657690 0.113939128877 0.007413406800 0.1132431962 0.0  
(…) 
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4.7. Threshold filter 
The Threshold Filter will extract data with a value between or upper or below given values.  

4.8. Cell centring filter 
Cassandra can be launched in two different ways on each system. Each system has its own launching 
script which will automatically 

4.9. Glyph representation 
The Glyph Filter provides glyphs (e.g. arrows, lines, spheres...) to represent vectors based data. 
Figure 14 shows an example of glyphs based representation.  

 

Figure 14: Glyph representation with Cassandra. 

4.10. 3D Picking Information filter 
Local information can be extracted with the Picking Information filter. After activation of the filter, select 
the data to probe in the 3D view with the mouse and type the p-key to pick the corresponding 
information (values, element id, etc...). Data can be localised on both nodes and cells. A detection 
radius or tolerance can be set. Figure 15 shows an example of picked data on the surface of an object.  
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Figure 15: Example of picking of local information (e.g. local value) on a given data 
set. 
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5. Cassandra in other contexts 
Cassandra is especially design to be easily integrated into other Java based applications for both 
generic and tailored purposes. This may include as well the adaptation of the GUI, the development of 
specific plug-ins or pre-define processing pipelines, in order to simplify complex data processing. A set 
of integrated data converter tools helps the loading and the import of business of specific formats.    

In this section, some examples of integration of Cassandra into Artenumʼs products and client 
development are presented.  

All information needed to integrate Cassandra in your application is available on the Cassandraʼs 
Developers Web Site.  

On demand, in the frame of the Cassandraʼs Service offer, Artenumʼs team can also fully perform this 
integration for you. Please feel free to contact our commercial services.  

5.1. Cassandra in the Keridwen IME: Application case to the 
ESA/SPIS system for the Spacecraft Plasma Interaction 
Simulation software 

Cassandra is integrated into Keridwen, the Artenum Integrated Modelling Environment (IME). 
Keridwen is an open-source softare (see www.keridwen.org) [4]. The Keridwen/Cassandra couple 
constitute the dedicated IME of the SPIS project (www.spis.org), initiated by the European Space 
Agency (ESA). SPIS is an open-source software dedicated to the detailed modelling of the spacecraft-
plasma interactions. It is used now by a large by a large international communtiy of users. SPIS in 
supported in the frame of the SPINE community (www.spis.org) [1] [2].  

Cassandra is here used in both pre and post-processing, from the visualisation of CAD models to the 
tailored analysis of results of simulations.  

 

Figure 16- Example of integration of Cassandra into a tailored application. Here the 
SPIS project of ESA. 
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5.2. Cassandra in Penelopeʼs Mesh Inspector 
Penelope is used in the Mesh Inspector of the Artenum Penelope Mesh library. This tool allows 
evaluating the quality of a tetrahedral mesh and performs corrections and edition. Penelope is an 
Artenum open-source project availble online (http://dev.artenum.com/projects/Penelope) [4]. 

 

 

Figure 17- Use of Cassandra in the Penelope Mesh Inspector. 
 

 

Figure 18: Extraction and visualisation of boundary elements with the Penelope Mesh 
inspector and Cassandra. 
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